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Chapter 1 
Overview 

CA on CD and Collective Index (CI) on CD provide you with complete access to Chemical Abstracts 
(CA) on easy-to-search CD-ROMs. 

CA includes a broad spectrum of technical and scientific information including Biochemistry, Physical, 
Inorganic, and Analytical Chemistry, Applied Chemistry and Chemical Engineering, Macromolecular 
Chemistry, and Organic Chemistry.  References may be in the form of journals, patents, technical 
reports, dissertations, conference proceedings, and books.   

 

These original references are available in 50 languages, while all are available in English in CA on CD.   

For a complete CA content description, refer to the CA on CD Content Description or the CI on CD 
Content Description manual. 

CA on CD is updated monthly and includes indexing information as it becomes available.  Each 
monthly update contains all of the information for the calendar year-to-date. 

Collective Indexes (CI) on CD comprise different CI on CD titles.  These products differ in time period 
covered and inclusion or non-inclusion of abstracts as follows: 

CI on CD Product Time Period 

14CI on CD with Abstracts 1997-2001 
14CI on CD (Indexes Only) 1997-2001 
13CI on CD with Abstracts 1992-1996 
13CI on CD (Indexes Only) 1992-1996 
12CI on CD with Abstracts 1987-1991 
12CI on CD (Indexes Only) 1987-1991 
11CI on CD with Abstracts 1982-1986 
11CI on CD (Indexes Only) 1982-1986 
10CI on CD with Abstracts 1977-1981 
10CI on CD (Indexes Only) 1977-1981 
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Overview of Differences between CA on CD and CI on CD 

The following differences in content or features exist between the CA on CD and CI on CD products 

Feature CA on CD CI on CD 
with 

Abstracts 

CI on CD 
Index Only 

Abstracts Searchable In Word Index Yes Abstracts 
displayable 

only 

Not applicable 

Left Hand Truncation in Word Index Starting in 
1999 

Starting with 
14CI on CD 

Starting with 
14CI on CD 

Expanded Display Option - Breaks Display 
Into Titled Fields 

Starting in 
1999 

Starting with 
14CI on CD 

Starting with 
14CI on CD 

Organization Word Index Available  Starting in 
2001 

Starting with 
14CI on CD 

Starting with 
14CI on CD 

Author and General Subject Hit-Term 
Highlighting 

Starting in 
1999 

Starting with 
14CI on CD 

Starting with 
14CI on CD 

Full Journal Titles Starting in 
2001 

Starting with 
14CI on CD 

Starting with 
14CI on CD 
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About This User Guide 

This User Guide is designed to introduce you to search features that can be used to retrieve 
information from CA on CD and CI on CD.  This guide also includes the menu features, commands, 
and functions found on CA on CD and CI on CD.  

The appendices describe each command and subcommand listed in the menus of the Main Menu bar, 
a list of stopwords, and customization setups. 

Throughout this guide, boldface type is used to indicate names of windows, buttons, pull-down items, 
and other features.  Italic type is used for items that you should type or enter.  Italic type is also used to 
indicate names of section and chapter headings when they are referred to in the text. 

The search examples show screens from CA on CD.  If there are any differences in content or search 
options between CA on CD and CI on CD, the differences are noted in the text.   

Most of the screens were captured from a Microsoft® Windows PC.  If the names of windows, buttons, 
pull-down items or other features are different on a Macintosh OS X machine, the differences are noted 
in the text. 

Record Content 

Information displayed may include: 

 CA Accession Number 
 CAS Registry Number 

 Bibliographic Information 
• Title 
• Abstract (only in CA on CD or CI on CD with Abstracts) 
• Author Names 
• Company Name/Corporate Source 
• Publication Year 
• Date, Publisher, Volume, Issue, Pagination, CODEN, ISSN 
• Language 
• CA Section 

 Patent Identification 
• Patent Families 
• Patent Information 
• Patent Assignee 
• Inventor 
• Application Information 
• Priority Information 
• CA Section 

 Document Type 
 Keywords 
 Index Entries 
 Chemical Names (CA index name) 
 Molecular Formula 
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Hardware, Memory, and System Requirements  

Contact CAS Software Support to obtain a detailed list of recommended equipment.  You can also 
obtain hardware requirements on the Web at http://www.cas.org/ONLINE/CD/cdreqs.pdf.  For 
troubleshooting information, consult the CAS Software Support Team Web page 
http://www.cas.org/Support/software.html. 

Starting CA on CD or CI on CD (Windows) 

1. Start CA on CD (Start | Program Files | CA on CD | CA on CD). 
2. Select Open Database from the File menu. 
3. Highlight the database name from the list of installed databases, e.g., CA on CD 1998, or 13CI on 

CD with Abstracts. 
4. Click Open. 

 The CA on CD splash screen is displayed. 

5. Click Click to Continue. 

 The CA on CD Main Menu bar is displayed.  The toolbar containing commonly accessed features  
is displayed below the Main Menu bar. 

 

Starting CA on CD or CI on CD (Macintosh OS X) 

1. Open the CAonCD OSX Folder 
2. Double-click the CA on CD OSX application icon 
3. Select a database from the Open Database list and click Open 
4. Click Agree to certify the license agreement  

The menu bar is displayed.  

 

Technical Support 

If you experience difficulties while installing or opening CA on CD, please contact CAS Customer 
Service: 

In U.S., Canada, and Mexico: All Other Countries: 
Phone: 800-753-4227 Phone: 614-447-3700 
 614-447-3731 
FAX: 614-447-3751 FAX: 614-447-3767 
Email: help@cas.org Email: intsales@cas.org 
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Help 

Help is available by selecting a command from the Help menu.  CA on CD Quick Start Tips with step-
by-step instructions on how to conduct typical searches in CA on CD is also available on the Internet.  
Click on Internet on the Main Menu bar and select CA on CD Quick Start Tips  
http://www.cas.org/ONLINE/CD/CACD/QUICKSTART.



8 

Chapter 2 

Browsing, Searching, and Displaying Records 
Browsing in Indexes 

Index Browse is used to find terms in the index of a specific search field.  To use this feature, select 
Index Browse from the Search menu.  The Index Browse window is displayed.  The Word Index is 
displayed by default. 

 

The Index Browse window (on a PC) 
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The Index Browse window (on a Macintosh OS X) 

Terms are listed in alphabetical order, with numeric terms listed first.  The number of documents and 
the total number of occurrences in all of the documents are listed to the left of each term. 
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Index Browse Fields 

The default index is the Word index.  To change to another index, click the arrow in the Index box.  

A menu listing the available index fields is displayed.  After selecting an index, the terms from that 
index are immediately displayed. 

Index fields include: 

• Word (default) 
• CAS RN (CAS Registry Number) 
• Author 
• Gen. Subj. (General Subjects) 
• Patent Number 
• Formula (Molecular Formula) 
• CAN (CA Abstract Number) 
• Organization (complete names of organizations or patent assignees) 
• Org. Words (single words from the names of organizations or patent assignees) 
• Journal 
• Language 
• Year 
• Doc. Type (document type) 
• CA Section 

 Note that the Org. Words (Organization Word Index) is available only in CA on CD 2001 and later. 

Locating and Selecting Index Terms 

Look for terms by scrolling the list with the vertical scroll bar, or by pressing the Page Up/Page Down 
keys or ▲/▼ keys.  After finding your term, click to select it. 

An easier and quicker method of locating a specific term is to begin typing the term in the Find box.  As 
each letter is typed, the screen moves to that section of the index and highlights the term representing 
the letters you have typed. 

For example, typing a B moves to the B section; typing BE moves to the BE terms in the index, etc.  
This feature, Speed Scroll, is executed by default and is set in your Preferences.  For details on 
changing this default, see Appendix E, Preferences. 
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Click an entry to select it.  To select multiple entries, press your Ctrl key (Windows) or the Apple key 
(Macintosh OS X) and click any number of entries to select.  Up to 20 multiple entries may be selected 
at one time. 
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Searching for Documents 

After finding and selecting index terms, either double-click the terms or click the  button in the 
index window.  The search results window is displayed listing the titles of documents that contain the 
index terms you searched.  

 

The document titles are listed in decreasing search term occurrence count order.  Document titles may 
also be listed by descending CAN (CA Accession Number) order by accessing Preferences in the File  
menu and changing the default display order.  Refer to Appendix E, Preferences, for more details. 
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Double-click a title to see its reference. If only one document is retrieved, its document record is 
immediately displayed. 

 

Displaying Multiple Documents from the Search Results List 

To quickly display another record while viewing a display record, select one of the following buttons: 

Windows OS X Description 

  

Displays the record of the document title that is listed after the record you are 
viewing in the Search Results dialog box.  This button is available only when a 
title follows the title you are viewing in the Search Results list. 

  

(Previous Document) displays the record of the document title that is listed 
before the record you are viewing from the Search Results dialog box.  This 
button is only available when a title precedes the title you are viewing in the 
Search Results list. 

 
 When displaying the next or the previous document, all displayed documents remain open until you 

close them. 
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Locating Search Terms within a Display Record 

To quickly move to searched terms within a display record, click either: 

Windows OS X Description 

 
  

Places the cursor at the next occurrence of a search or hit term.  This button is 
only available when a hit term appears beyond the current cursor position. 

  

(Previous Hit) places the cursor at the previous occurrence of a search or hit 
term.  This button is available only if a hit term precedes the location of the 
cursor. 

Displaying Labels with Fields 

For records in CA on CD 1999 and later, you have the option to view the labels for the bibliographic 
fields, e.g., TITLE, in records. 

To display the labels for the bibliographic information, select View from the Text pull-down menu and 
choose the Full View format (Windows). 

On a Macintosh OS X machine, select Format from the View menu.  Choose Document View or Full 
View. 

Displaying Full Text Information 

Click the Full Text icon to see full-text options for the citation.  You are automatically connected to 
ChemPort on the Web through your Web browser.  A list of full-text options for the citation is displayed.  
Close your Web browser to get back to the CD product. 

Extending your search to the open Web via eScience 

Extend your search to the open Web using the eScience link.  Clicking on the eScience (eSci) icon 
automatically transports your search terms to the eScience Web page where you can search the Web.  
This feature is available if your site administrator enabled Web support during installation. 
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Displaying Hyperlinked Data 

Within a CA record CAS Registry Numbers are automatically hyperlinked to their substance records.   
Any referenced web address is also hyperlinked if web access has been enabled by your CA on CD 
administrator during installation.  To quickly locate a hyperlink, click NextLink.  The cursor is placed at 
the first occurrence of a hyperlink within the record. 

 

If the link is a CAS Registry Number, click Goto or click the hyperlinked CAS Registry Number.  The 
substance records display the CAS Registry Number, CA index names, and the molecular formula.  

To find other records containing this CAS Registry Number, click Search on the substance record's 
toolbar.  If multiple records are found, they are displayed in a search results window.  If only one record 
is found, it is immediately displayed. 

If the link is a Web address, click Goto or click the hyperlinked Web address to initiate your Web 
browser and display the associated Web page. 

To move to the next hyperlink, click NextLink again.  The cursor is placed at the next hyperlink within 
the text. 

Patent Family records also contain links.  The NextLink and Goto icons may be used with Patent 
Family records to jump to the abstracted document if it is in the currently opened database. 
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Chapter 3 
Word Search 
Search Fields in Word Search 

Word Search is used to create a search strategy of one or more terms in a specific search field.  
Search fields and their definitions include: 

Word (CA on CD) Single words from document titles, abstracts, keywords, organization 
location, General Subject Headings, and index modification phrases. 
Word is the default. 

Word (CI on CD) Single words from document titles, keywords, organization location, 
General Subject Headings, and index modification phrases. Word is the 
default. 

CAS RN CAS Registry Numbers 

Author  Author names 

Gen. Subj. General Subject Index headings 

Patent No. Patent country code and patent number (includes patent application 
number) from both patent document records and patent families 

Formula Substance molecular formulas 

Compound Compounds or chemical names 

CAN CA Accession Number 

Organization Organizations, corporate source, patent assignees, and corporate authors 
(complete names) 

Org. Words* Single words from the names of organizations or patent assignees 

Journal Journal titles (full titles, abbreviated titles prior to 2001 CA on CD and 
prior to 14CI on CD) 

Language Language of the source document 

Year Source document publication year 

Doc. Type Type of document 

CA Section CA section number and title as a bound phrase, CA section, and section 
cross-reference numbers.  Search queries can be restricted to a particular 
section grouping by either selecting the section grouping name as a 
bound phrase from the CA SECTION index or entering the first letter of 
the section grouping name into the Word Search box with a wild card, 
e.g., A*, to limit the search results to the APPLIED CHEMISTRY & 
CHEMICAL ENGINEERING (Sections 47-64). 

Update Bound phrases of the form YYYY-UU (such as 1996-02 or 1996-12) and 
VVV-II (such as 120-04).  The YYYY-UU entries correspond to the CA on 
CD year and update number.  The VVV-II correspond to CA volume and 
issue numbers. 

 
• Note that the Org. Words (Organization Word Index) is available starting with CA on CD 2001 and 

14CI on CD. 
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Searching within the Word Search Window 

Select Word Search from the Search menu.  The Word Search window is displayed (Windows).  On a 
Macintosh OS X machine, the Search Template window is displayed. Click in the first word entry box.  
Then type a term or a phrase.  Either accept the Word default search field or click the arrow in the 
Search Fields box to display the pull-down menu.  Select a search field.  Continue typing terms in the 
word entry boxes that follow and selecting search fields as needed.  You may enter multiple terms per 
line, with Boolean operators, only in the Word, Author, CA Section, and CAS RN fields. Up to 25 search 
terms, not counting Boolean operators, can be entered per query. 

 

To retrieve documents for your query, click the Search button in the window.   
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If more than one document is found, the document titles are listed in decreasing search term 
occurrence count in the search results window.  If only one record is retrieved, its record is displayed 
immediately. 

 You may also choose to list document titles by decreasing accession number order by changing 
Preferences.  See Appendix E for information. 
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Entering Terms with Wild Cards 

Use Wild Cards with search terms or phrases if you are unsure of spelling, if you want to retrieve word 
variations, e.g., singular or plural forms of a term, if you need terms with the same word stem, e.g., 
BIOCHEMICAL, BIOCHEMISTRY, or if you want to mask characters within a string, e.g., NITRATE, 
NITRITE. 

Wild cards include: 

? adds exactly one character to your term at the location point of the wild card, e.g., 
BASE? may retrieve BASES or BASED; CH2??O2 may retrieve CH2BrO2 or 
CH2ClO2 

* adds 0 or more characters to the end of your term, e.g., ADSOR* may retrieve 
ADSORB, ADSORPTION, or ADSORBENTS  

Note that you can use the wild card symbols at the beginning of a term only in the Word index and 
only in CA on CD 1999 and later.  For example, you can search a term such as *ASSAY* to retrieve 
words such as IMMUNOASSAY, RADIOIMMUNOASSAY, ASSAYING, etc. 

Combining Search Terms with Boolean Operators 

Use Boolean operators to combine multiple search terms.  The operators are located to the left of the 
word entry boxes.  Click the arrow in the box with “and” to see the pulldown menu.  Select a Boolean 
operator. 

The Boolean operators include: 

and retrieves records that include all search terms.  AND may decrease the number of 
records retrieved. 

or retrieves records that include any search term or all terms.  OR may maximize the 
number of records retrieved as it expands the number of terms in your search. 

not retrieves records that include the first term but not the second term. NOT may 
eliminate unwanted documents. 
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For example: 

 

The order of query execution is always left to right for the terms on the same line, and top to bottom. 
There is no assumed order of precedence of the Boolean operators.  Thus the above query is executed 
as follows: 

(Angiograph* AND (coronary or cardiovascular)) AND Aczel* 

Word Proximity 

Word proximity is available only in the Word and Org. Words indexes.  All other search indexes are 
“bound phrases” and must be matched exactly.  Two methods to specify proximity relations include: 

 Entering multi-word phrases to specify adjacent words.  For example, entering genetic 
engineering  will be searched as GENETIC immediately followed by ENGINEERING. 
Entering Dow Chemical  in the Org. Words index will be searched as DOW followed by 
CHEMICAL.  Note that the Word Relationship controls at the bottom of the Word Search 
window have no effect on this type of proximity specification. 

 Entering words on separate lines to specify that two words have a proximity relation other 
than adjacent.  

Note that the Org. Words (Organization Word Index) is available only in CA on CD 2001 and later. 
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Setting Search Term Relationships 

Word Relationship, located at the bottom of the Word Search window, lets you specify the relationship 
that multiple search terms may have within a document record.   

Word relationships include: 

Same Document retrieves documents that contain the search terms in the document in 
any order.  Same Document is the default. 

Same Paragraph retrieves documents that contain the search terms in any order within 
the same "paragraph."  In the Word index, a paragraph is defined as 
the same paragraph of text, the same title, or the same index entry.  
The bibliographic data for one document are also considered a 
paragraph. 

Words Apart retrieves documents that contain the search terms within a certain 
proximity of each other.  The range may be from 0-9 intervening 
words.  The default is 9. 

Exact Order retrieves documents that contain the search terms in the exact order 
that you typed them.   This option is only available when you have 
selected the Words Apart option.  The default retrieves results in any 
order, e.g., SHALE OIL, OIL SHALE. 

 These search term relationship options apply to terms between rows in the Word Search window.  
Terms entered in the same row, without Boolean operators, are always adjacent. 

Searching Terms Found in a Document Record 

While browsing a display record, you may want to search a term within the text to retrieve additional 
information concerning your topic. 

To search a term found within the document, highlight the term.  Then select Search for Selection 
from the Search menu or click the SrchSel icon.  

If documents are found, their titles are listed in the Search Results window.  If only one document is 
found, its record is immediately displayed. 
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Chapter 4 
Substance Hierarchy 

The Substance Hierarchy consists of a series of levels of CA index names, having a hierarchical 
organization based on chemical structure. Each level of the hierarchy adds more chemical name 
information. There are several nested levels of substance names. 

The first level heading is listed in alphabetical order with numeric entries listed first. 

 For more information about substance hierarchies, refer to the CA on CD Content Description or 
CI on CD Content Description. 

To use this feature, select Substance Hierarchy from the Search menu.  The Substance Hierarchy 
window is displayed and lists the first level headings. 

 

Terms proceeded by a + symbol expand the hierarchy.  Terms preceded by a - symbol contract the 
hierarchy.  The substance hierarchy may contain up to six nested levels of substance names. 

 The initial Substance Hierarchy window does not list terms that are collapsible.  You must expand a 
substance at least one level to list substances that may be collapsed. 
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Using the Substance Hierarchy 

Search Example:  Find references on the current CA on CD database to 4-(acetylamino)benzoic acid. 

1. Select Substance Hierarchy. 

 Type the parent name of the substance, i.e., benzoic acid, in the Find box.  As you type, the list scrolls 
to entries around the term of interest.  This is Level 1 of the Substance Hierarchy.   

Click on the name of the substance of interest.  If the substance name is preceded by a +, click 
Expand to display the next level of the hierarchy. 
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2. Level 2 of the Substance Hierarchy for the substance of interest is displayed. 

Click on the entry of interest.  If the entry is preceded by a +, click Expand to display the next level of 
the hierarchy.  If the entry is preceded by a -, click Collapse to display the preceding level of the 
hierarchy.   
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3. Level 3 of the Substance Hierarchy is displayed.  Click on the entry of interest.  If the 
substance name is followed by a CAS Registry Number in brackets, click Document 
(Windows) or Search (Macintosh OS X) to display a list of titles for the references citing the 
substance.  If there is only one document title, the document record is displayed. 
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Chapter 5 
Formula Hierarchy 
The Formula Hierarchy is a list of molecular formulas in a hierarchical organization based on chemical 
structure.  The Formula Hierarchy leads to substance names.  Within each formula, the elements are 
listed in Hill Order.  Substance names are arranged with a hierarchical organization, where formulas 
having a large number of document references are subdivided into groups by chemical name 
subdivisions.  There are several nested levels of chemical names. 
 
To use this feature, select Formula Hierarchy from the Search menu.  The Formula Hierarchy 
window is displayed and lists the first level headings. 

 

All first level terms are preceded by a + symbol to expand the hierarchy. 
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Using the Formula Hierarchy 

Search Example:  

Find references on the current CA on CD database to 4-(acetylamino)benzoic acid, using its molecular 
formula of C9H9NO3. 

1. Select Formula Hierarchy.  Type the molecular formula in the Find box. 

As you type, the list scrolls to entries around the formula of interest.  This is Level 1 of the Formula 
Hierarchy.  Click on the molecular formula of interest.  To expand the hierarchy of a term, double click 
on a term with a + symbol next to it.  Or highlight that term and click Expand to display the next level of 
the hierarchy.  

 

 For compounds represented in the CAS Registry System as dot-disconnected formulas, each 
component is indexed (except for single atom fragments unless they are the entire formula).   
For example, H2MnO4.2K is indexed under H2MnO4 but not under K as entries listed under the 
formula K are for the element, not the salt. 
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2. Level 2 of the Formula Hierarchy for the molecular formula of interest is displayed.  Click on a 
substance name of interest.  Click Expand to display the next level of the hierarchy. 
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3. Level 3 of the Formula Hierarchy is displayed.  
Click on an entry of interest.  If the entry is preceded by a +, click Expand to display the next level 
of the hierarchy. If the entry is preceded by a -, click Collapse to display the preceding level of the 
hierarchy.   
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4. The next level of the Formula Hierarchy is displayed. Click on the entry of interest.  If the entry is 
followed by a CAS Registry Number in brackets, click Document to display a list of reference titles 
citing the substance.  
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If there is only one reference citing the substance, that reference is displayed. 
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Chapter 6 
Printing, Saving, and Ordering Documents 

With CA on CD or CI on CD you can:   

• print document titles or records 
• save document titles or records to disk 
• obtain information on full-text options for a record 
• print order forms for document delivery from the CAS Document Detective Service (DDS) 

Printing 

To print titles from the Search Results window, click Print.  You are prompted to choose the titles to 
print: All, Selection, or Window.  If you choose Selection, only the highlighted titles will be printed. 

When printing documents from a Document window, you have the following options:  

All - prints or saves the entire document record  
Bibliographic - prints or saves the bibliographic sections  
Bibliographic -  prints or saves the bibliographic sections and the abstract  
and Abstract 

Before printing records, you can change the display format.  On a Windows machine, select View from 
the TEXT pull-down menu.  On a Macintosh machine, select File|Preferences and change the default 
document view format.  The Full View format includes labels such as TITLE for the different parts of 
the bibliographic data.  The Document View (default) format does not include those labels. 

 Note that the Full View format is available only in CA on CD 1999 and later. 

Records are printed in the point size and font displayed on the screen.  For best results, the True Type 
Fonts are recommended.  To change either the point size or the font, select Font from the Text menu 
(Windows) or the View menu (Macintosh OS X). 

Saving  

To save titles from the Search Results window, click Save and select save options. 

When saving documents from a Document window, you have the following options:  

All - prints or saves the entire document record  
Bibliographic - prints or saves the bibliographic sections  
Bibliographic -  prints or saves the bibliographic sections and the abstract  
and Abstract 

Before saving records, you can change the display format.  On a Windows machine, select View from 
the TEXT pull-down menu (on a Macintosh OS X machine, select Format from the View menu) and 
change the default document view format.  The Full View format includes labels such as TITLE for the 
different parts of the bibliographic data.  The Document View (default) format does not include those 
labels. 

 Note that the Full View format is available only in CA on CD starting in 1999. 
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If you select the Full View format option prior to saving documents, this view will be used when the 
documents are saved as Text (.TXT) or Rich Text Format (.RTF) files. 

Saved formats include: 

Text Files - saves textual data, according to the text view format selected. 

Tabbed Files - saves textual data where the data corresponds to tag units separated by TAB 
characters.  This text file is usable by other database programs. 

Comma Files - saves textual data where the data corresponds to tag units separated by 
COMMA characters.  This text file is usable by other database programs. 

Rich Text Files - saves textual data as well as any structures that are included as part of the 
abstracts, according to the text view format selected. 

Tagged Files - saves textual data and tags each data type.  Tags include: 

AN Accession Number 
TI Document Title 
BI Bibliographic Information 
AB Abstract Text 
KW Keyword Index Entries 
IN CA General Subject Index Entries and CA Chemical Substance 

Index Entries 

 Note that in the CA on CD records starting in 1999, the following tags appear in place of the 
BI tag in earlier records: 

AU Author 
CS Corporate Source 
CS2 Additional Corporate Source  
SO Source 
JT Journal Title 
VOL Volume 
ISS Issue 
PAGE Page Number(s) 
LANG Language 
PY Publication Year 
COD CODEN 
ISSN ISSN 
ID Series Issue Identification 
PTI Series Title 
CONFDAT Conference Date 
ED Editor 
PUB Publisher 
PUBPLC Place of Publication 
EDR Editor Role 
AV Availability 
TYPE Patent Type 
PNMBR Patent Number 
DATE Patent Date 
CTRY Patent Country 
CLAS Patent Class 
APNO Patent Application Number 
APDT Patent Application Date 
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PRIR Patent Priority 
DT Document Type 
SC CA Section 
SCXNUM CA Section Cross-references 

Printing DDS Order Forms 

To print a DDS order form for the currently viewed record, click DDS.   

Printing, Saving, and Ordering Marked Documents 

You may also mark the titles for printing, saving, or creating document order forms for DDS by following 
these steps in the Search Results window: 

1. Click on a title 
2. Click Mark  
3. Repeat Steps 1 and 2 until titles of interest are marked 
4. Click PrintMk, to print titles.  Click SaveMk, to save titles to disk.  Click DDSMrk, to print DDS order 

forms. 

To mark all the titles, click MarkAll.   Click Clear to unmark the highlighted titles. 

Another way to mark documents for printing, saving, or creating document order forms is to follow these 
steps: 

1. Click the Mark button while viewing each desired record. 
2. Return to the list of document titles in the Search Results window. 
3. Click PrintMk to print records.  Click SaveMk to save records to disk.  Click DDSMrk to print DDS 

order forms. 

A limit of 1,000 references may be saved, printed, or ordered at one time. 

Obtaining Full Text Information 

You may also obtain information on full-text options for a record displayed in the Record window. 

Simply click the Full-Text button. 
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Chapter 7 
Using Bookmarks 

Use bookmarks to record a specific location in a document.  A document record must be open to use 
the bookmark feature.  Once a bookmark is created, you may access it at any time without recreating 
the search. 

To create a bookmark, execute a search by selecting either Index Browse or Word Search.  While 
displaying a record, place your cursor at the location where you want the bookmark placed.  Then 
select Add... from the Bookmark menu (Windows) or Add Bookmark… from the Bookmarks Menu 
(Mac OS X).  Either accept the default bookmark name proposed by CA on CD in the Bookmark Title 
window or type a new name.  Then click OK. All bookmarks are saved to a default file e.g. CA2006.bkm 
(Windows), Bookmarks.plist (Mac OS X). 

To permanently save bookmarks to the default bookmark file (Windows), select Save from the File 
menu and drag your cursor to the right.  Select Bookmark List.  To permanently save bookmarks to a 
bookmark file name other than the default, select Save As from the File menu and drag your cursor to 
the right.  Select Bookmark List.  Then enter the location and file name for your bookmark list and 
select OK.  Bookmarks are automatically saved permanently on Macintosh OS X. 

To open an existing Bookmark (Windows), select Bookmark List from the Bookmark menu.  Select a 
Bookmark title from the Bookmark - [filename.bkm] window, where [filename.bkm] is the default file 
where the Bookmarks are stored.  Click Goto.  The record is displayed as it was when you created the 
Bookmark. 

To open an existing Bookmark (Macintosh OS X), select Show Bookmarks from the Bookmarks 
menu and select a Bookmark title. 

To delete a Bookmark (Windows), click Bookmark List from the Bookmark menu.  A list of Bookmarks 
is displayed in the Bookmark - [filename.bkm] window.  Select a Bookmark.  Then click Delete.   

To quickly delete all Bookmarks, click Delete All. 

To delete a Bookmark (Macintosh OS X), select Show Bookmarks from the Bookmarks menu, select 
a Bookmark title and click Remove.  Then confirm Delete. 
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Chapter 8 
Saving Search Queries 
Saving Queries (Windows) 

To save a search query, click Query List in the Word Search window after you have created your 
search.   

 

The Saved Queries window is displayed (example shown for 2001 database)`. 

 

Click Add.  A Query Title window appears with the default query name in the Enter Title of Query 
text box.  Accept the default or type a query name of your choice.  The added title is listed in the 
Queries window.  
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Click Close to exit the Query Title window.  To use a saved search query, enter the Word Search 
window and click Query List.   

 

To search a query, select its name and click Recall.  Your search query, saved with the selected 
query name, is inserted into the Word Search template.  You may search the recalled query or edit it. 

To remove a saved search query, select its name and click Delete.  

To quickly remove all saved queries from the list, click Delete All. 

Click Print All to print all queries.  There is no option to print selective queries. 

You may also specify a default query file (other than the database name query file, e.g., ca2001.qry) 
to be used for all databases you open.  Please refer to the Appendix E, Preferences for information. 
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Saving Queries (Macintosh OS X) 

To save a search strategy, select Word Search from the Search menu.  Create a search strategy.  
Then click Save Query... from the Search Template window. 

A dialog box is displayed and prompts you to enter a query name.  Type a name of your choice. 

 

Click OK. 

To restore a saved search query, select Word Search from the File menu.  Then click Query Log...  
A window is displayed listing the saved queries.  Double-click the query name or select a query name 
and click OK.  The query is restored in the Search Template. 

To remove a saved query, select Word Search from the Search menu.  Then click Query Log...  A 
window is displayed listing the saved queries.  Select a query name and click Remove. 

To print the contents of the query log, click PrintAll. 

You may also specify a default query file (other than the database name query file, e.g., ca2001.qry) 
to be used for all databases you open.  Please refer to the Appendix E, Preferences for information. 
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Appendix A 
Main Menu (Windows) 

Many of the menu commands are common to your Windows system.   

The following tables describe each menu command in their respective menu. 

File Menu 

Menu Item Definition 

New  Allows you to create a new, untitled 
Bookmark List file or Query List file 

Open  Opens an existing database, Bookmark 
List, or Query List 

Save  Save Window saves the active document 
or search results list.  Save Bookmark List 
saves the Bookmark List to its named file. 
Save Query List saves the Query List to its 
named file. 

Save As  Saves an existing Bookmark List file or 
Query List file to a new file name 

Close Closes the active window 

Print DDS... Prints the DDS order form for the display 
record you are viewing 

Print Setup... Selects printer settings for documents and 
DDS order forms to be printed 

Print                      Ctrl+P Prints the document or a search results list 

Preferences... Customizes your session by changing 
defaults 

Exit                       Ctrl+Q Exits the session 
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Edit Menu 

Menu Item Definition 

Copy                     Ctrl+C  Copies a selected block of text that can be 
pasted to a location of your choice 

Search Menu 

Menu Item Definition 

Index Browse Lists terms in specific indexes.  Terms are 
listed alphabetically, with numeric terms 
listed first. 

Word Search... Opens Word Search; allows you to create 
a search strategy in specific search fields 

Substance Hierarchy Lists CA index names, in a hierarchical 
organization, where names having a large 
number of document references are 
subdivided into groups by heading 
subdivisions. Terms are listed 
alphabetically, with numeric terms listed 
first. 

Formula Hierarchy Lists molecular formulas, in a hierarchical 
organization, where formulas having a 
large number of chemical name references 
are subdivided into groups by 
subdivisions.  Terms are listed 
alphabetically, with numeric terms listed 
first. 

Search for Selection Searches the database for a term 
highlighted in a document record  

Link to Selection Displays the substance record for the CAS 
Registry Number that you have highlighted 
or that your cursor precedes; displays the 
abstracted documents for Patent Family 
records if it is in the current year’s CA 
database, initiates your web browser and 
displays the web page for the web link that 
you have highlighted or that your cursor 
precedes if web access has been enabled 
by your administration during installation. 
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Text Menu 

Menu Item Definition 

Font... Displays options for modifying the font, 
font style, and point size of text for printing 
and displaying 

View Displays options for document viewing 
formats 

Window Menu 

Menu Item Definition 

Cascade            Shift+F5 Arranges all open windows on top of each 
other, like a set of index cards 

Tile                    Shift+F4 Arranges open windows next to each other 
in reduced size 

Arrange Icons Arranges icons in the main window 

Close All Closes all open windows 

[Window titles] Lists the first nine open Windows 

 
 Window commands are added for the first nine open windows by window title, 
e.g., opening Word Search lists Word Search in the Window menu.   
If more than nine windows are open, More... Windows is added to the 
Windows menu.  Select More... to see the rest of the open windows. 

Bookmark Menu 

Menu Item Definition 

Bookmark List Displays the current Bookmark List 

Add... Adds a bookmark to the current 
Bookmarks List for the current active 
record 
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Internet Menu 

Menu Item Definition 

CA on CD Quick Start 
Tips 

Provides step-by-step instructions on how 
to conduct typical searches in CA on CD 

CAS Software Support Connects to the web page of CAS 
Software Support with information on 
installation and troubleshooting 

ChemPort Connects to ChemPort for full-text of 
documents on the Web 

STN Easy Connects to STN Easy® 

American Chemical 
Society (ACS) / 
ChemCenter® 

Connects to the ACS Web page 

ACS Publications Connects to the ACS publications Web 
page 

Chemical Abstracts 
Service (CAS) 

Connects to the CAS Web page 

eScience Connects to the eScience Homepage for 
general information about eScience 

Help Menu 

Menu Item Definition 

Contents Opens the help file 

About... If a database is currently open, displays 
information about the database and 
copyright information.  If a database is not 
currently open, displays the product 
version number and copyright 
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Appendix B 
Main Menu (Macintosh OS X) 

Many of the menu commands are common to your Apple Macintosh system.  The following tables 
describe each menu command in their respective menu. 

CA on CD Menu 

Menu Item Definition 

About CA on CD Details of current application 

About Current Database Details of current database 

Preferences...             , Customizes your session 

Services         OS X functions 

Hide CA on CD          H Minimize CA on CD windows 

Hide Others           Alt H Minimize all other windows except CA on 
CD 

Show All Show all windows 

Quit CA on CD          Q Exits the CD product 

File Menu 

Menu Item Definition 

New Notepad...         N Opens a new, untitled notepad 

Open Notepad...       O Opens an existing notepad 

Open Database...  O Opens a new database 

Close                        W Closes the current window 

Close All              Alt W Closes all open windows 

Save                          S Saves a document or notepad to a 
specified file or disk 

Revert Reverts to previous saved Query Log 

Page Setup...         P Allows you to customize your page setup 

Print...                        P Prints the document or notepad 

Print DDS... Prints the DDS order form for the display 
record you are viewing or the record you 
have marked in your Search Results list 
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Edit Menu 

Menu Item Definition 

Undo                         Z Undoes previous action 

Redo                      Z Redoes previously undone action 

Copy                          C Copies a selected block of text that can be 
pasted to a location of your choice 

Paste                         V Places cut or copied text at the location of 
your cursor 

Delete Deletes selected text 

Select All                   A Selects an entire document 
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Search Menu  

Menu Item Definition 

Index Browse              E Lists terms in specific indexes.  Terms are 
listed alphabetically, with numeric terms 
listed first. 

Word Search              R Opens Word Search, which allows you to 
create a search strategy in specific search 
fields 

Substance Hierarchy  U Lists CA index names, in a hierarchical 
organization, where names having a large 
number of document references are 
subdivided into groups by heading 
subdivisions. Terms are listed 
alphabetically, with numeric terms listed 
first. 

Formula Hierarchy      K Lists molecular formulas, in a hierarchical 
organization, where formulas having a 
large number of chemical name references 
are subdivided into groups by 
subdivisions.  Terms are listed 
alphabetically, with numeric terms listed 
first. 

Search for Selection   F Searches the database for a term 
highlighted in a document record 

Link to Selection         L Displays the substance record for the CAS 
Registry Number that you have highlighted 
or that your cursor precedes; displays the 
abstracted documents for Patent Family 
records if it is in the current year’s CA 
database, initiates your web browser and 
displays the web page for the web link that 
you have highlighted or that your cursor 
precedes if web access has been enabled 
by your administration during installation. 
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View Menu 

Menu Item Definition 

Font       Displays a submenu with font options for 
printing and displaying online 

Format       Displays 2 selections for viewing 
documents: Document View and Full View 

Show/Hide Toolbar Displays/hides Document and Search 
Results window toolbars 

Customize Toolbar… Allows you to customize Document and 
Search Results window toolbars 

Bookmarks Menu 

Menu Item Definition 

Show Bookmarks    O Lists the bookmarks in the current 
Bookmark List.  Selecting a bookmark 
opens a window with that record in it. 

Add Bookmark… Adds a bookmark to the Bookmark List for 
the current active record. 

Window Menu 

Menu Item Definition 

Minimize Minimizes active window 

Zoom Maximizes active window 

Bring All to Front Displays all CA on CD windows in front of 
windows from other open applications 

<Window Title> Lists the open windows.  Selecting a 
window causes that window to become the 
active window. 
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Internet Menu 

Menu Item Definition 

CA on CD Quick Start 
Tips 

Provides step-by-step instructions on how 
to conduct typical searches in CA on CD 

CAS Software Support Connects to the Web page of CAS 
Software Support with information on 
installation and troubleshooting 

ChemPort Connects to ChemPort for full-text of 
documents on the Web 

STN Easy Connects to STN Easy® 

American Chemical 
Society (ACS)/ 
ChemCenter® 

Connects to the ACS Web page 

ACS Publications Connects to the ACS publications Web 
page 

Chemical Abstracts 
Service (CAS) 

Connects to the CAS Web page 

eScience Connects to the eScience Homepage for 
general information about eScience 

Help Menu 

Menu Item Definition 

CA on CD™ Help        ? Displays help for the current active window 
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Appendix C 
Icons & Their Definitions 

The icons available in CA on CD or CI on CD windows and dialog boxes are defined below. 

Windows OS X Definition 

  

Opens the Index Browse window and lists terms in specific indexes.  Terms are 
listed alphabetically, with numeric terms listed first. 

  

Opens Word Search, which allows you to create a search strategy in specific 
search fields.  In document or hit list windows, this opens the Word Search 
window with the query associated with the document or window you are viewing 
inserted in the template. 

  

Opens an index of CA index names, in a hierarchical organization 

  

Opens an index of molecular formulas, in a hierarchical organization 

  

In a non-patent record, either displays the substance record for the CAS 
Registry Number that is highlighted or that your cursor precedes, or initiates 
your web browser and displays the web page for the link that is highlighted, 
provided web access is enabled 

  

Moves to the next occurrence of a CAS Registry Number Link or the next 
occurrence of a Web Link in non-patent records or CA abstract number in 
Patent Family records. 

  

Searches (in the Word index) for the text you have highlighted within a display 
record 

  

Prints the document or the search results list you are viewing 

 

Saves the document or the search results list you are viewing to a file name of 
your choosing 

  

Moves to the previous occurrence of the search (hit) term.  This icon is 
available only if a hit term precedes the location of your cursor 

 
  

Moves to the next occurrence of the search (hit) term.  This icon is available 
only If a hit term exists beyond the location of your cursor. 

  

Displays the document that precedes the record you are viewing, based on the 
order of the Search Results list.  This icon is only available if a document 
precedes the one you are viewing. 

  

Displays the document that is listed after the record you are viewing, based on 
the order of the search results list.  This icon is only available if a document is 
listed after the one you are viewing. 
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Windows OS X Definition 

  

Marks the document record you are viewing or the document title you have 
highlighted in the Search Results list 

  

Unmarks the document record you are viewing or all document titles that have 
been marked in the Search Results list 

  

Marks all document titles in the Search Results list 

  

Unmarks the document you are viewing or all document titles that have been 
marked in the Search Results list 

  

Prints the documents that you have marked in the Search Results list 

  

Saves the documents that you have marked in the Search Results list 

  

Prints a DDS (CAS Document Detective Service) order form, including the 
bibliographic or patent information, for the record you are viewing 

  

Prints a DDS (CAS Document Detective Service) order form, including the 
bibliographic or patent information, for the document titles you have marked in 
the Search Results list 

 

N/A Searches for substance records containing the CAS Registry Number in the 
substance record 

 

N/A Closes the substance record window that you are viewing 

  

Requests help for its current context 

  

Connects to ChemPort for full-text options 

  

Connects to eScience to search on the Web. 

 

N/A Displays previous screen 

 

N/A Displays next screen 
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Appendix D 
Stopwords 

Stopwords are words that are not indexed because they are too frequently used.  The following 
stopwords apply in CA on CD and the CI on CD products. 

The stopwords: "A", "6" also apply to the CI on CD products. 

0 
1 
2 
3 
4 
5 
7 
8 
9 
10 
AN  
AND 
ARE 
AS 
AT 
B 
BE 
BY 
C 
FOR 
FROM 
I 
II 
IN 
IS 
NOT 
OF 
ON 
OR 
RELATION 
THAT 
THE 
THESE 
THIS 
TO 
WAS 
WERE 
WHICH 
WITH 
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Appendix E 

Preferences  

Preferences (Windows) 

Select Preferences from the File menu to customize your session by changing default settings.  The 
Preferences dialog box is displayed. 

 

Set the Words Apart value between 0 and 9.  This value is equivalent to the maximum number of 
words that may exist between multiple search terms.  9 is the default. 

Choose to Display Search Results by Descending CAN (CA Accession Number) Order or by 
Relevance (search term occurrence count).  The default is Relevance. 

If Use a single browser for all WWW links is selected, the software attempts to reuse an existing 
Web browser window if it is already running.  If it is not running, the software launches your Web 
browser. 

Launch a new browser window for each WWW link option starts a new instance of your Web 
browser each time you access a Web feature.  It allows you to have multiple Web activities open at one 
time. 

Override Windows default browser option lets you override the default browser. 

Choose to connect to ChemPort via secure or non-secure connection.  The default is Use secure 
connection for ChemPort. 

Turn Speed Scroll Word List on or off.  Utilizing this feature allows you to automatically scroll through 
a search field index as you are typing a word in any of the scrollable indexes.  The default executes the 
Speed Scroll feature.  

Choose to turn on or off the Maximize Windows options.  It is turned on by default. 

Click OK after making any modifications or click Cancel to ignore the changes. 
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In the Default Query Filename, you may specify a default query file (other than the database name 
query file, e.g., ca2001.qry) to be used for all databases you open.  If a query file name is specified, the 
software will automatically open the specified query file whenever a database is opened.  If the field is 
blank, the database name query file is opened. 

Preferences (Macintosh OS X) 

Select Preferences… from the CA on CD menu.  Select Document tag and customize your session by 
changing default settings.   

 

Set your default font and point size.   

Choose Default Document View: 

• Document View (without labels for bibliographic information) 
• Full View (with labels for bibliographic information) 

 You may also change the font and view type for a specific window by accessing the View menu. 
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Select General tag to Sort search results and specify default query file name 

 

Choose to Sort Search results by: 

• Descending CAN Order 
• Relevance 

In the Query File, you may click Change… and specify a default query file (other than the application 
name query file, e.g., CA on CDTM Query Log) to be used for all databases you open.  If a query file 
name is specified, the software will automatically open the specified query file whenever a database is 
opened.   

Click OK after making any modifications or Cancel to cancel the request. 
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